Microsoft Access 2010
Intro to Forms and Reports
Forms are primarily created for data entry. Reports are typically an organized 'print out' of data. The design structure of forms and reports are very similar. In this workshop we will learn how to use the built in tools to create forms and reports, as well as creating them from a blank canvas. Topics include using the AutoForm/AutoReport tool, and the Form and Report Wizards. Creating forms and reports in the design view - including: using the property sheet; field placement, sizing, aligning, and formatting; simple command buttons; working with multiple sections on a report; stacked and tabular tables; sorting reports; and creating mailing labels.
**Forms**

Most forms display one record at a time, but you can build your form so it will display multiple records. As you develop your forms you can create navigation buttons, insert graphics, and change the colors to display everything consistently. The basic views of a form are design view, layout view, and form view.

Your data source is most often a Table, but can be a Query. Tables provide all the records, Queries offer a subset. For example, if I want to see all the Patients I would use the Table; if I only want to see Dr. Edward's Patients, I would use a Query as my record source.

The data entered or modified in a form is automatically saved to the table. The table is the true location of the data; the form is just a “pretty” way to work with the data.

If you would like to view more than one record at a time you may wish to use a "Multiple Items" form, or a “Split Form”. Multiple Items, also called a Tabular or Continuous form, shows multiple formatted records. Split Forms show the form view and a datasheet view for the same data.
Creating a Form
You can construct a new form from the Forms group on the Create tab. Select the table or query you would like to use as the record source from the navigation pane and then choose the type of form you would like to build.

Form
The first button, listed simply as “Form”, will create a Form to view data one record at a time. If the record source is a table with a one-to-many relationship, the data table may have a Subdatasheet attached. If this is the case, Access will create a form with an imbedded datasheet.

Form Design
The Form Design button creates a blank form with no record source and opens the form directly into the design view. These are often used to create a series of command buttons to make menus and can be modified to point to a record source so it can be used to display or edit data.
**Blank Form**

The Blank Form button creates a form with no record source.

Like the Form Design button, this newly created form can be a custom built form for menu, or connected to a record source to work with the data.

![Blank Form](image)

**Multiple Items**

Multiple Item forms are also known as Tabular (in the wizard) or Continuous Forms (in the properties).

These forms allow you to see multiple records like a datasheet, but each record can have form objects and can display formatting you would not see in the datasheet view.

These forms can display headers and footers which can also hold buttons such as close form and new record.

![Multiple Items](image)
**Datasheet**

The Datasheet Form will create a form that looks like the datasheet view of a table or query. These forms are useful to create SubForms.

![Datasheet Image]

**Split Form**

A Split Form creates a duel view of your dataset; the Datasheet view showing multiple records and a Form view showing one record at a time.

You can edit, add, and remove data from either section of the form.

As you choose different records in the Datasheet section the Form section will display the same record.

In the design view you can adjust the split form properties to move it to the top, left, or right. And you can lock it so it cannot be resized.

![Split Form Image]
Modal Dialog

When a Modal Form is opened in the Form view it has the focus of the application, like the Open File dialog box, you cannot do anything else until you have closed the window.

This is a useful form when you are creating warning and error messages such as “Do you really want to exit?”

The OK and Cancel buttons are created automatically. Both buttons are set to close the form, if you need them to do more you will need to modify the macros in their event properties.

Pivot Chart

Pivot charts allow you to arrange the fields from your record source into a graph. It is recommended that you create a query first to see the true values of lookups and pull out only the relative data.
**Pivot Table**

Pivot Table Forms allow you to arrange the fields from your record source into a table.

You will be able to choose where each field will be placed.

It is recommended that you create a query first to see the true values of lookups and pull out only the relative data.

**Form Wizard**

You can choose from more than one (related) table or query.
Choose a Layout:

**Columnar – Form**

**Tabular – Multiple Items/Continuous**

**Datasheet – Table/Query view**

**Justified – Only available through wizard**

Be sure to use a consistent naming convention.

There are extra steps when the data comes from a one-to-many relationship. This is discussed in the full 2-hour Forms workshop.
Reports
Reports are designed to create an organized output of information from your database. With a report, you can group and summarize information. You can’t edit the data in a report, but if you make the modifications in the table, query, or form you will see the results when you open the report again. Reports have four basic views, Report, Print Preview, Layout and Design.

Creating a Report
You can construct a new report from the Report group on the Create tab. Select the table or query you would like to use as the record source from the navigation pane and then choose the type of report you would like to build.

Report
The first button, listed simply as “Report”, will create a basic report listing the data in columns. This AutoReport often will need to be modified to fit the data. The field size property (set in the tables) will determine the width of the fields.

Report Design
The Report Design button creates a blank report with no record source and opens the report directly into the design view.
**Blank Report**

The Blank Report button will create a report with no record source. Blank forms can be used as a starting point of a custom report, if you want the report to print data you need to assign a record source.

![Blank Report](image1)

**Report Wizard**

The Report Wizard guides you through building your report. You can choose from more than one related table or query.

![Report Wizard](image2)
You can Group by any field and change the grouping option using the button in the bottom left corner.

We did grouping in the basics workshop and will revisit it for the full Reports workshop.

If you sort with the Report Wizard, keep in mind Access will move these fields to the beginning of the report which often rearranges the order of you fields. You can sort in the design view of the completed report.

Choose the Page Orientation. If the Adjust the field widths... box is not checked your data may run across several pages. You can choose from the three common layouts:

- Columnar
- Tabular
- Justified
Be sure to use a consistent naming convention.

There are extra steps when the data is grouped. This is discussed in the Reports workshop.

Labels
Labels are usually used to create mailing labels and name tags. You can create these through a Mail Merge in Microsoft Word, or here in Access by using the Label Wizard.

Make sure you select the correct database object in the Navigation Pane, this wizard does not give you a chance to change the record source.

Choose the label product number. The number should be listed on the box of labels.

Most labels come with an Avery equivalent number, but Access does offer a list of other manufacturers.
Choose the font format for the label.

Build the label one field at a time, typing in characters as needed.

Choose the sort order.

Name the label report. It’s a good idea to use the label number in the name.

You may get an error message. This often happens with labels because they are very close to the edge of the page. Usually the report will print without a problem, but this error message may come up as a warning every time you run the report.
Designing Forms and Reports
There are many similarities between the basic design view of Forms and Reports.

Above is the label and text box for the Last name of our patient in design view. A label appears the same in both design and data view. A text box shows the field name it’s pulling from the record source and will display the actual data in the form or print preview. Whether you are in the design view of a Form or a Report, when you select a Text box, it will look like this:

**Labels and Text Boxes**
Moving with the Mouse
When you place your mouse anywhere on the edge of the text box, between the sizing handles, your mouse arrow will turn into the move pointer ( ). This pointer also appears when you click and hold on an unselected object. When you click and drag the mouse while the pointer shows this arrow, both the label and the text box will move.

The upper left corner of the label and the text box both show a square larger than the sizing handles, this is to identify the link between the text box and its label. When you place the mouse in this large square, your pointer will still show the moving pointer ( ), however when you drag from this corner the item will move independently of its partner text/label box. To separate a label from its text box, you can cut and paste the label.

Font Size
When you change the font size, Access will not resize the box. If you place your mouse over one of the sizing handles and double-click, Access will AutoFit the selected box to the correct height. If it is a label it will attempt to adjust to the width.

**Working in the Design View**
Moving with the Keyboard
You can move items one grid point at a time by using the arrows on the keyboard; you can move an object a quarter of a grid point by pressing Ctrl in conjunction with the arrow keys.
Resizing
When you place your mouse on the any of the selected objects sizing handles you will get a double arrow (➚<不留). Click and drag the mouse and the box will resize the selected items. Remember Access anchors in the upper left corner, so you are generally growing away or toward this corner.

The Shift key used in conjunction with the arrow keys on the keyboard, allow you to adjust the size of your object. Using Shift and Ctrl will resize a quarter of a grid point at a time. The arrange tab for both Forms and Reports has a Size group where you can adjust the objects relative to each other.

Making Multiple Selections
1. Shift Key: To select more than one item in the design view, click on the first item and then hold down the shift key on the keyboard and click on each subsequent item you wish to select. If you mean to include the labels, don’t forget to click on them as well.
2. Items in a Line: When the objects you would like to select are all in a row or column, you can click in the ruler and Access will select everything in the path of that selection.
3. Selection Box: If you click in a part of the grid that is unoccupied by any objects and drag the mouse over the objects you would like to select, you will see a selection box being drawn. Any items that the selection box touches will be selected be careful with this, especially in reports where there are so many lines.

No matter how the object is selected, Shift-Click can be used to unselect a selected object.

Design Tab
The Design tab of the Forms and Reports are almost identical.

Report Design Tab

Form Design Tab

The Tools group on the far right contains three of the most important buttons: Add Existing Fields, Property Sheet, and Tab Order.

Add Existing Fields
The Add Existing Fields button opens the Field List for the current form or report. From here you can drag and drop fields onto the design view. Each field will automatically create a label one inch to the left of the field. Remember when you drop your field; Access is dropping the top left corner of your object. If you are missing a field from this list then it does not exist in your data source. You will need to modify the table or query and when you return it should be on this list.
The **Property Sheet** button will replace the field list with the **Property Sheet**. This window can stay open, it will change the listed options depending on the object selected on the form or report.

Field properties such as formats can be modified here to differ from the table or query. Field properties are listed in *Tables and Field Properties* handout. This window can also be opened by right-clicking on any object and choosing properties.

**Tab Order**

The Tab Order button opens a window to help you adjust the order the keyboard will move through the controls in the Form View, using the Tab, Enter, or Arrow keys.

If the form is aligned properly, you can usually press the **Auto Order** button at the bottom of the window. To customize the order use the small gray select box in front of each control name. This window can be frustrating because those little gray boxes are all you can click on in the fields.

**Group & Sort (Reports)**

Data can be sorted in tables, queries and forms. Since we cannot edit the data of a report, it’s difficult to sort without creating a query first. The design view of a report has a feature **Group & Sort**. This button will be opened as a panel across the bottom of the window.

Click the **Add a group** or **Add a sort** button to create new groups and sort orders. When you add a Group, Access will create a Header for that field/expression. This will be discussed in further detail in the full Reports workshop.

We will play with the Group options found under **More** in the 2-hour Access Reports workshop.

**Controls**

When you select a control you use it once and it turns off. If you double-click the tool will turn it on and keep it on. Press **Esc** or click on the white **Select** arrow to return to 'normal'. Forms and Reports share most of their controls. In Office 2010 we can only see a few controls at a time. You can click on the directional Up and Down arrows, or click on the expand button to see all of the control options.
### Select
Use to select an object, a section, a form, or a report.

### Text Box
Text boxes are different in data view and in design view. Data can come from the data source or calculation.

### Label
Labels display the same information in the design view and the data view. They are most often used for titles, captions, or instructions.

### Command Button
Create a button to perform simple tasks such as record navigation and form and report operations.

### Tab Control
Use to create a tabbed form with several pages. Each page has its own tab order.

### Hyperlink
Create a link to a Web page, a picture, an email address or a program.

### Web Browser Control (Form Only)
Allows you to display Web pages on a form. Will only work in Access 2010.

### Navigation Control (Form Only)
Use to insert SubForms in a tabular format. Will only work in Access 2010.

### Option Group
Use to create a section of related check boxes or option buttons.

### Insert Page Break
Used to create a new page on printouts of a form or report. Be careful not to leave any extra space below a page break within its section.

### Combo Box
Create a lookup via a drop down menu. You can type in the text box or select an entry in the drop down box to add a value to a bound field.

### Chart
Place a chart on the form/report and Access will take you through a Chart wizard.

### Line
Draws a line. Used to emphasize related information. Set Height property to zero for a straight line.

### Toggle Button
Use as a stand-alone control bound to a Yes/No field. If you want more than one toggle button you should create an option group.
<table>
<thead>
<tr>
<th><strong>Forms</strong></th>
<th><strong>Reports</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="List Box" /></td>
<td><img src="image" alt="Rectangle" /></td>
</tr>
<tr>
<td><strong>List Box</strong>&lt;br&gt;Create a lookup via a list of options.&lt;br&gt;The list box will display all the possible choices and highlight only the chosen option.</td>
<td><strong>Rectangle</strong>&lt;br&gt;Draws a rectangle. Used mostly for visual clarity of groups.</td>
</tr>
<tr>
<td><img src="image" alt="Check Box" /></td>
<td><img src="image" alt="Unbound Object Frame" /></td>
</tr>
<tr>
<td><strong>Check Box</strong>&lt;br&gt;Use as a stand-alone control bound to a Yes/No field. If you want more than one check box to correspond to the same field you should create an option group.</td>
<td><strong>Unbound Object Frame</strong>&lt;br&gt;Use to display an unbound OLE object, such as an Excel spreadsheet. The object will remain constant on each page or record.</td>
</tr>
<tr>
<td><img src="image" alt="Attachment" /></td>
<td><img src="image" alt="Option Button" /></td>
</tr>
<tr>
<td><strong>Attachment</strong>&lt;br&gt;Use to display attachment objects saved in a field in the record source.&lt;br&gt;(not available in compatibility mode)</td>
<td><strong>Option Button</strong>&lt;br&gt;Use as a stand-alone control bound to a Yes/No field. If you want more than one option button you should create an option group.</td>
</tr>
<tr>
<td><img src="image" alt="SubForm/SubReport" /></td>
<td><img src="image" alt="Bound Object Frame" /></td>
</tr>
<tr>
<td><strong>SubForm/SubReport</strong>&lt;br&gt;Use to create or insert a form or report into the current form or report to see data from another data source. For example the medications for each patient.</td>
<td><strong>Bound Object Frame</strong>&lt;br&gt;Use to display OLE objects saved in a field in the record source. A different object will be displayed for each record.</td>
</tr>
<tr>
<td><img src="image" alt="Image" /></td>
<td><img src="image" alt="Set Control Defaults" /></td>
</tr>
<tr>
<td><strong>Image</strong>&lt;br&gt;Use for displaying a static picture on a form or report, such as a logo.</td>
<td><strong>Set Control Defaults</strong>&lt;br&gt;Set the default of the currently selected control. When you make another of the same control, it will match the new default value.</td>
</tr>
<tr>
<td><img src="image" alt="Use Control Wizards" /></td>
<td><img src="image" alt="ActiveX Controls" /></td>
</tr>
<tr>
<td><strong>Use Control Wizards</strong>&lt;br&gt;Turns control wizards on or off. When you try to create a control such as a command button the wizard will be launched when the object is placed on the form or report. If the wizard does not activate make sure this button it turned on.</td>
<td><strong>ActiveX Controls</strong>&lt;br&gt;Use to access a menu that displays other controls you can utilize to create your form or report, such as a PDF Reader or a Macromedia Flash Object.</td>
</tr>
</tbody>
</table>
The last control Insert Image is very similar to the Insert Picture found in the list of controls. The difference is when you use the Insert Image button, Access will remember the image and offer an Image Gallery of all the recent graphics used so you can use the image again on other Forms and Reports without having to browse for the image.

**Arrange Tab**

The Arrange tab of the Forms and Reports are also very similar.

Many of the Align, Size, Position, and Layout groups can be found through the right-click menu.

**Size/Space**

**Size** - The To Fit option is the same as double-clicking on the sizing handles, it will fit all the selected objects to their own best fit. It will always adjust the height, but for controls bound to a control source, Access will only adjust the height, not the width.

_Tallest_ and _Shortest_ are the vertical sizes, _Widest_ and _Narrowest_ are the horizontal sizes. As you move and align objects it's possible they will shift off the grid. The To Grid option helps keep controls lined up.

**Spacing** - The spacing options will only be available when you have multiple items selected. We use this instead of "align center" to adjust the spacing between the selected objects.

Text boxes will often move their labels with them. To adjust the spacing of the text boxes, use your shift key to ONLY select those controls before you change the spacing.

**Grid** - The Grid helps give us a visual alignment, but when a form/report becomes complicated, sometimes it's nice to turn off the Grid so you can see in more detail.

Turning off the ruler will give us a little more space to see all the objects on our Form/Report.

The Snap to Grid option will help line up objects as you move them around the form/report.

**Grouping** - Several objects can be grouped together so when they are moved or deleted Access will take them all together.
Aligning Objects
These options will only be available if more than one object is selected. Unlike the other Microsoft Office products, Access’s Align feature has no Center or Middle, to adjust your controls it would be better to use the vertical/horizontal spacing found under the Size/Space button.

There is also no Align to Form/Report. These options are only for the selected controls.

Access will not overlap controls. If two controls are in a direct line, they will be placed touching each other along the adjoining edge.

Tables
The rest of the buttons on the Arrange tab help you work with tables. Stacked and Tabular are new options to Office 2007/2010. They allow you to create a table of objects. When you resize or move one object, Access will adjust all the grouped objects. This is helpful to be able to reorder the fields without constant position adjustments.

Once a set of controls are put into a table layout you can add gridlines, work with the rows and columns and even merge and split the cells.

If you are used to using Access 2003 or earlier these new table tools will seem very foreign. I promise they are worth the effort to figure out.

Format Tab

The Selection box is useful to find an elusive control. Often it’s hard to see lines and page breaks, the selection drop down here on the Format tab, or from the top of the Property Sheet will help you select that control.

The Font formats can be found on the Home tab, or here on the Format tab. Remember when you change the text size the control will not automatically resize to fit the new settings.

If a Number format is not available, make sure you are on a Number field. If Access won’t let you set the format you wish from this group, you can change the format in the Property Sheet.

The Background Image will show up behind the grid. If you want a logo or floating image, use the design tab. In the property sheet you can tell Access how you want the image to appear, such as stretching the image to fit the size of your form.
If the form is set to be Continuous (Multiple Items/Tabular), Access can display more than one formatted record at a time. Reports do this automatically. For a Continuous form, or for any report, you can set an Alternate row color to differentiate between the records.

Some controls such as buttons can have different Styles and Shapes.

The conditional formatting button will allow you to apply formats to the control object depending on an expression that you create. For example, we could grey out inactive patients, or mark past due dates in red. Access 2010 even allows you to compare the field to others in the same dataset.

The last three buttons Shape Fill, Outline, and Effects allow you to customize your own format instead of using the Shape Styles.
Class Exercise
FORMS

1. Select Departments Table
   - Create Tab, **Form**
   - Notice the SubDatasheet
   - Close and Save as **Departments**

2. Select Employee Table
   - Create Tab, **Form**
   - Explore Layout View
   - Close and Don't Save

3. Select Employee Table
   - Create and close without saving... (see pg 3-5)
     - Modal
     - Multiple
     - Datasheet
     - Split Form

4. Form Wizard
   - Use all fields of Employees Table
   - Layout: Justified
   - Save as **Employees**

5. New Form Design View
   - Adjust grid size, 5" x 2"
   - Open Property sheet
     - Record source: Patients
   - Open **Add Existing Fields** (field list)

6. Drag field **Med Rec** from Field List to 1" down, 2"
   - Label and Text box
   - Go to Form View

7. Form Properties
   - Allow Datasheet View: No
   - Allow PivotTable View: No
   - Allow Pivot Chart View: No
   - Allow Layout View: No
8. Design view (see pg 13-14)
   - Sizing Handles
   - Moving Together
   - Moving Separately
   - Click off, click on and drag
   - Enter to toggle text

9. Build Form
   - Keep Form 5"x2"
   - Make sure you can view all the labels in the Form view.

10. Design view - Formatting (see pg 18-19)
    - Selecting Multiple Objects
    - Alignments
    - Sizing
    - Spacing

11. Form View – Navigating
    - Enter, Tab, Down, Right -> Forward
    - Shift-Tab, Up, Left -> Backwards
    - F2 to edit, or click inside

12. Design View Switch First & Last Name
    - Form View, tab order out of sync
    - Adjust Tab Order (Design tab or right-click grid)
    - Form View tab order works

13. Design View - Add Buttons from controls on Design tab
    - Previous
    - Next
    - Close

14. Save as Patients

REPORTS
1. Select the table Patients
   - Create Tab, Report
   - Explore Layout View
   - Close and Don't Save
2. Report Wizard (see pg 9-10)
   - Columnar
     - Table Patients using all the fields
     - No Grouping
     - No Sorting
     - Columnar, Portrait
     - Save as **Patients Columnar**

   - Columnar
     - Table Patients using all the fields
     - No Grouping
     - No Sorting
     - Tabular, Portrait
     - Save as **Patients Tabular**

   - Justified
     - Table Patients using all the fields
     - No Grouping
     - No Sorting
     - Justified, Portrait
     - Save as **Patients Justified 1**

3. Modify the Design of the Patients table

   **field size**
   - Med Rec 10
   - Last 50
   - First 50
   - Address 255
   - City 50
   - ST 2
   - Zip 15
   - Close and Save
   - Yes, it's ok if data is lost

4. Report Wizard Justified Again
   - Table Patients using all the fields
   - No Grouping
   - No Sorting
   - Justified, Portrait
   - Save as **Patients Justified 2**
5. Delete all reports

6. Report Wizard Landscape Patients
   - Table Patients using all the fields
   - No Grouping
   - No Sorting
   - Tabular, Landscape
   - Save as Patients

7. Preview Patients – Parts of the Window
   - Set Zoom to four pages
   - Report Header, first page only
   - Page Header/Footer, every page
   - Detail, every record

8. Design View – Add Report Footer
   - Increase size of Report Footer
   - Add a Label: Created by ____
   - Format Label
   - Close and Save

   - Set Report Property, Record source to Patients
   - Add Med Rec from field list (add existing fields)
   - Adjust Detail Size
   - Move Med Rec Label to Page Header
     - Cut/Paste Med Rec Label
   - Add Last Name column to match
   - Select all, Delete

12. Table – Tabular vs. Stacked
    - Open Field List
    - select Med Rec through Zip (use shift)
    - Drag to the Report design
    - With everything selected, choose Stacked from the Arrange Tab
    - Choose Tabular from the Arrange Tab
    - Close and don’t save
13. Report Wizard Sorted
   - Patients, All fields
   - No Group
   - Sort by City Descending, Last Ascending
   - Tabular, Landscape
   - Save as Patients Sorted

14. Adjust Report
   - Go to the design view
   - Select everything in the page header and detail
   - from the Arrange tab choose Tabular
   - Unselect everything (click in an empty space)
   - Select just the City Label and City Text box
   - move City into place between address and zip
   - Repeat for the Last Name
   - Close and Save Report

15. Open the report Patients
   - Filter by City
   - Toggle filter (Home tab)
   - Go to the design view
   - Open the Sorting and Grouping Options
     - From the ribbon or right-click menu
   - Sort by City "with Z on top"
   - Sort by Last Name "With A on top"
   - Close and Save

16. Select Table Patients (see pg 11-12)
   - Create Tab, Report, Labels
   - find 5160
   - Leave Font set as is
   - Build Label using keyboard as needed
   - No Sorting
   - Save As Labels Patients 5160
   - Say OK to the error message

17. View design of label
   - Open Property sheet
   - Change Record Source to "Patients - No Boxes"